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Toon Boom Storyboard Pro 6.0.3
Here is the list of changes in Storyboard Pro 6.0.3, build 14.20.3.14252 (2018-12-14):
l

Enhancements on page 4

l

Fixed Issues on page 4
IMPORTANT
An important fix was made to the licensing mechanic of Storyboard Pro in this release. If your
studio uses a license server, you must upgrade to Storyboard Pro 6.0.3 on the license server before
upgrading your workstations. If your license server uses Harmony 15.0.1 or later, you do not need
to upgrade it.

Enhancements
l

The Generate Auto-Matte command was added at the bottom of the contextual menu that appears
when right-clicking on a layer.

l

It is now possible to assign a keyboard shortcut to the Convert to Drawing command of the Layer menu.

Fixed Issues
The following issues have been fixed:
l

Crash when connecting a Thunderbolt device on macOS.

l

Storyboard Pro displays welcome screen when opening a project directly in Finder in macOS 10.14
(Mojave).

l

Top menu is not responsive when opening a project directly in Finder in macOS 10.14 (Mojave).

l

When splitting a panel containing snapshots, its snapshots are moved to the first of the two panels.

l

After dragging and dropping a selection of multiple layers in a panel, only one of the layers is selected.

l

The toggle state of the Action Safe Area and Title Safe Area are both saved to the same preference.

l

The pixel density of bitmap drawings and textured vector drawings is not exported when exporting
Harmony scenes.

l

Copying and pasting a layer into a new panel renames the layer even if its original name is not taken by
any other layer in the target panel.

l

Splitting a scene does not immediately update the name and number of its panels.
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Toon Boom Storyboard Pro 6.0.2
Here is the list of changes in Storyboard Pro 6.0.2, build 14.20.2.13969:
l

Features on page 5
l

l

Scripting on page 5

Bug Fixes on page 5

Features
Scripting
Feature

Description

Automatte on
source
layer

The LayerManager.generateMatteLayer() method can now generate the matte directly on the
source layer instead of in a new layer. To do this, pass an object with the onNewLayer property set to
false to its options parameter.

Layer
index in
layer
selection

Selected layer objects returned by the SelectionManager:getLayerSelection() method now
have a layerIndex property. This property specifies the actual index of the selected layer in the
panel's layer list.

NOTE
The index property is still present. It specifies the order in which the layer was added to the
selection.

Bug Fixes
l

Fixed issue causing artwork drawn with a Wacom Stylus/Cintiq tablet to be offset on Windows since the
Wacom driver update 6.3.30-6.

l

Fixed issue causing some projects to no longer synchronize audio clips with panels and scenes when
editing the duration of panels.

l

Fixed issue where using the LayerManager.generateMatteLayer() method with a colour that has
an alpha value would ignore the alpha value and generate an opaque matte.
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Toon Boom Storyboard Pro 6.0.1
Here is the list of changes in Storyboard Pro 6.0.1, build 14.20.1.13760:
l

Features & Enhancements
l

Video Clips on page 6

l

Drawing

l

Staging on page 7

l

Export on page 7

l

Project Structure

l

Scripting on page 9

l

Enhancements

l

Bug Fixes

Features & Enhancements
Video Clips
Feature

Description

Split clip

The Split Clip at Current Frame command can now be used with both video clips and sound
clips.

Copy and paste
keyframes

It is now possible to copy and paste animation keyframes in video clips.

Drawing
Feature

Description

Auto-Matte on
source layer

When generating a matte for your artwork using the Generate Auto-Matte dialog, you now
have the option to generate the matte directly on the same layer as the artwork instead of in
a new separate layer.

Modifier keys for
Stamp and
Bitmap Brush tools

The following modifier keys, which could be used when drawing with the Brush tool and
Pencil tool on a vector layer, can now be used when drawing with the Stamp tool, as well
as when drawing with the Brush tool on a bitmap layer:

6

Storyboard Pro 6.0.2 Release Notes

Feature

Description

l

l

l

l

l

If you press and hold the Shift key before you start drawing, your stroke will be a
straight line.
If you press and hold the Shift key while you're drawing, the part of your stroke from
that point on will be a straight line until you release the Shift key.
If you press and hold the Shift and the Alt keys before drawing, your stroke will be a
straight line in an angle that is a multiple of 15 degrees.
If you press and hold the Ctrl (Windows) or ⌘ (macOS) key while drawing, your
stroke will be a closed shape.
If you press and hold the Alt key, your tool will snap in a straight line to the nearest
existing shape.

Staging
Feature

Description

Enable Action Safe
Area and Title Safe
Area separately

In the Stage and Camera views, the Safe Area option would display the Action Safe Area
and the Title Safe Area inside the camera frame. This option has been split into two
options: One to display the Action Safe Area and one to display the Title Safe Area.

Export
Feature

Disable
optimization when
exporting
to Harmony

Description

The Optimize Still Images option was added to the Export to Harmony dialog.
Since Storyboard Pro 6.0.0, when exporting Harmony scenes with a rendered animatic,
spans with no layer animation or camera movement would be rendered as a single drawing
with its exposure extended. This is now optional. By unchecking this option, you can
render your animatic with one drawing per frame.

Use variables in
Scene Options
when exporting
to Harmony

When exporting Harmony scenes, if you use the options in the Scene Options tab to set the
path and prefixes to use for rendering the scene's frames, you can now use variables to
make the path and the prefix include the project name as well as the act, sequence and
scene number. This allows you to make each exported scene have a different image render
path and image prefix.

Burn in Action Safe
Area and Title Safe

When exporting movies, Harmony scenes, PDF documents, EDL/XML/AAF sequences or
conformation projects, the Safe Area option would burn in both the Action Safe Area and
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Feature

Description

Area separately

the Title Safe Area into the exported images and movies. This option has been split into two
options: One to display the Action Safe Area and one to display the Title Safe Area

Project Structure
Feature

Description

A new script is packaged, TB_RenamePanelProject, which contains two useful
functions:
l

l

TB_RenamePanelByScene will rename all panels in the selected scene. The panels
in each selected scene will be numbered sequentially starting from 1 for the first
panel in each scene.
TB_RenamePanelProject will rename all panels in the project. The panels in the
project will be numbered sequentially starting from 1 for the first panel in the
project. The number sequence will continue across scenes, meaning each panel will
have a unique number in the entire project.

Because scripts are stored in your preferences and preferences are stored by major version,
this script will not be automatically copied to your preferences if you used Storyboard Pro
6.0.0 before. You can copy it manually to your preferences.

How to copy the new script manually on Windows
Rename Panel
script

1. Open a Command Prompt:
l

l

l

On Windows 7: Open the Start menu and select All Programs
> Accessories > Command Prompt.
On Windows 8.1: Open the Start menu, then open the Apps drawer
and, under Windows System, click on Command Prompt.
On Windows 10: Open the Start menu and, in the applications list,
select Windows System > Command Prompt.

2. Type in the following command and press Enter:
> COPY "C:\Program Files
(x86)\Toon Boom Animation\Toon Boom Storyboard Pro
6\resources\scripts\sboard\TB_RenamePanelProject.js"
"%APPDATA%\Toon Boom Animation\Toon Boom Storyboard
Pro\14200-scripts\"

How to copy the new script manually on macOS
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Feature

Description

1. Open a Terminal window:
l

In the Dock, click on the Launchpad icon, then select Other and click on
Terminal.

2. Type in the following command press Enter:
$ cp "/Applications/Toon Boom Storyboard Pro
6/tba/resources/scripts/sboard/TB_RenamePanelProject.js"
"$HOME/Library/Preferences/Toon Boom Animation/Toon Boom
Storyboard Pro/14200-scripts/"

Scripting
Feature

Description

Enhancements were made to the scripting documentation packaged with Storyboard Pro:
l

The style and layout has been updated.

l

A tree view navigation pane was added to the left of the documentation to make
navigation easier.

Documentation
l

Most of the information that is not useful to users, such as private classes and
members, hierarchy graphs and file references was removed.

The scripting documentation can be viewed by opening the view menu

in the Script Editor

view and selecting Help > Scripting Interface Documentation.

Enhancements
l

When updating the position of a rendered 3D model, the rotation sphere used to rotate the model will
preserve its previous angle. This sphere appears when holding Ctrl + Shift (Windows) or Shift + ⌘ (Mac
OS X), then clicking and dragging the model.

l

The logic for the Random Size parameter of the Brush and Stamp tools has been enhanced so that you
no longer need to reduce the minimum size of the brush for the random size parameter to work.

l

The following enhancements were made to the install wizard on Windows:
l

The installation wizard for Windows is now able to upgrade from a previous version of
Storyboard Pro without requiring the user to manually uninstall it first.

l

Installation on Windows is now faster. The installer no longer registers the fonts packaged with
Storyboard Pro into the Windows fonts database.

9

Bug Fixes
l

Fixed issue causing Storyboard Pro to initialize the machine’s printer on launch. If the printer’s drivers
had issues, they would be triggered when launching Storyboard Pro.

l

Fixed issue where panels with a vertical camera movement would appear cropped in an exported PDF
with the Full Page and Expand Panel options enabled.

l

Fixed issue where selecting an audio clip then selecting a video track would add the video clip at the
current frame to the selection.

l

Fixed issue causing selected clips to get deselected when moving a selection of video clips on multiple
video tracks.

l

Fixed issue causing the selected clip to be deselected where moving a video clip while the timeline cursor
is over it.

l

Fixed issue preventing from selecting video and audio clips simultaneously when selecting a video clip
first.

l

Fixed issue causing the dialog prompting to import preferences from previous version of Storyboard Pro
to appear in English when launching the application in a different language.

l

Fixed issue where, when exporting a movie as a sequence of image files, a directory would automatically
be created in the target directory and image files would be exported in it. Exported image files are now
saved directly in the target directory.

l

Fixed the differences between the available image formats in the Scene Options tab of the Export to
Harmony dialog and the image formats supported by Harmony:
l

Added Digital Picture Exchange (.dpx), OpenEXR (.exr), Portable Document File (.pdf) and
Deep Texture (.dtex) to the list.

l

l

Removed Toon Boom Vector Graphics Optimized (.tvgo) from the list.

Fixed issue where creating a brush preset with the same name as a previously deleted brush preset
would reload the preview of the deleted brush preset.

l

Fixed issue where the tool properties of the Brush tool would not update when selecting a vector or
bitmap layer, then adding a layer of a different type.

l

Fixed issue where, when using the Shift or Alt key to draw a straight line with a drawing tool and
releasing it while drawing the stroke, a short zig-zag would be drawn near the straight line.

l

Fixed issue where the brush size cursor, which can be enabled in the Tools tab of the Preferences, would
appear when using the Stamp tool and would indicate the wrong brush size.

l

Fixed issue causing video clips to be hidden when drawing with the Realistic Preview option enabled.

l

Fixed issue where, when drawing with the Realistic Preview option enabled, new strokes would not
display while they were being drawn.

l

Fixed a rare crash when importing certain Alembic (.abc) 3D models.
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l

Fixed a potential crash when exporting Harmony scenes with burn-in options enabled.

l

Fixed issue causing rendered 3D models to not appear in exported Storyboard Pro scenes when
exporting with the Nest Panels in Symbols option is unchecked.

l

Fixed issue causing application to be invisible on launch if it was exited in a maximized state the last time
it was running on macOS.

l

Fixed issue that occurred when exporting a multi-layer Photoshop Document (.psd) file from a project
with video tracks. The layers in the PSD file that corresponded to the video tracks would always be
underneath all other layers.

l

Fixed issue where, when updating the position of a rendered 3D model, undoing it then attempting to
update its position again, the model would appear in the position that was undone in the Update
Model Position dialog.

l

Fixed issue where clicking on the artwork of a different layer with the Select tool while holding down the
Ctrl (Windows/Linux) or ⌘ (macOS) key would not select that layer.

l

Fixed issue causing groups to be converted to layers when creating a template made from a selection of
multiple layers and groups.

l

Fixed issue causing video clips to get clipped when pasting a sound clip in the same time span.

l

Fixed issue causing the project to be shortened by a single frame when adding a transition between
scenes while the Preserve project length when adding transitions is enabled.

l

Fixed issue causing colour pots to be temporarily missing from the Colour view when copying panels
from an existing project and pasting them to a new project.

l

Fixed issue causing layers in imported Photoshop Document (.psd) files to be ignored if their opacity is
below 9%.

l

Fixed issue where movie files exported with a frame rate of 23.976 FPS would have an extra frame.

l

Fixed issue where burn-in would sometimes not appear in exported Harmony scenes.

l

Fixed issue causing the LayerManager.isEmpty method to return the opposite value.

l

Fixed issue causing the LayerrManager.generateMatteLayer method to return true when using
a radius of 0, which fails to generate a matte.
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Toon Boom Storyboard Pro 6
Here is the list of changes in Storyboard Pro 6.0.0, build 14.20.0.13334:
l

l

Features on page 12
l

Animatic on page 12

l

Drawing Tools on page 14

l

Library on page 16

l

3D Objects on page 16

l

Export to PDF on page 17

l

Export to Bitmap on page 18

l

Export to Harmony Scenes on page 18

l

Export Audio on page 19

l

Project Management on page 20

l

Conformation on page 20

l

Preferences on page 20

l

Scripting on page 21

Bug Fixes on page 22

Features
Animatic
Feature

Description

Video tracks and
video clips

Storyboard Pro now features video tracks, in which you can add image or video clips to
display them in your animatic.
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Feature

Description

Video tracks can be placed above or below the storyboard track, to make its clips display
over or underneath the artwork in your animatic. Image and video clips can span over
several panels or scenes and be cued and clipped at any time in the animatic. They can be
transformed and animated, just like layers in a panel, but contrary to layers in a panel, they
are not affected by camera movements.
Audio and video
track reordering

It is now possible to reorder audio tracks as well as video tracks.

Audio and video
track renaming

It is now possible to assign custom names to audio tracks as well as video tracks.

You can search for a sound clip in your animatic by entering part or all of its file name and
going through each matching result.
Find sound clips

Display timecode

You can now display the timecode of the current frame in the top-left corner of the Stage
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Feature

Description

and Camera view by clicking on the Timecode

button in the status bar.

Drawing Tools
Feature

Description

The new Stamp

tool can be used to stamp one or several drawings into your artwork.

You can stamp drawings one at a time or draw strokes with it. The behaviour of the stamp
tool when drawing strokes can be customized in many ways.

Stamp tool

NOTE
The Stamp tool replaces the Dynamic Brush option of the Brush tool in Storyboard
Pro 5.5 and earlier.

The Brush tool now has the same texture drawing capabilities when used on vector layers
as when used on bitmap layers.
Textured vector
brushes
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Feature

Description

The Centerline Editor tool allows you to manipulate brush strokes, whether solid or
textured, by their centreline, giving you better control over their shape than the Contour
Editor.
Centerline Editor

The Contour Editor, Envelope and Perspective tools can deform the texture in textured
vector brush strokes.
Texture
deformation

The Polyline tool, which was available in Harmony, has been added to Storyboard Pro. With
this tool, you can draw segmented lines or shapes by creating each point composing the
line, allowing you to draw shapes with precision. The lines created with the Polyline tool
can be straight or curvilinear.
Polyline tool

Onion Skin for
Selected Layers
Only

You can now enable Onion Skin only for currently selected layers. When this option is
enabled, only artwork in layers that have the same name as the selected layer in surrounding
panels will appear in the Onion Skin.

Merge Down

There is now a command to quickly merge the selected layer with the layer just below it.
You can access it in the Layer menu, a layer's contextual menu or by pressing Ctrl + E
(Windows) or ⌘ + E (macOS).

Perspective tool
modes

The Perspective tool can now be used in either Perspective

or Lattice

mode. The

Perspective mode deforms the drawing by simulating a perspective effect, whereas the
Lattice mode simply deforms the drawing to make it fit the shape of the control box.
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Feature

Description

Directional Blur

In the Directional Blur dialog, you can now set the angle of the blur by clicking and
dragging on a dial.

Library
Feature

Description

Multiple layers
templates

You can now create templates with a selection of multiple layers. Importing such templates
into a panel will add all of its layers to the panel.

Multiple panels
templates

You can now create templates with a selection of multiple storyboard panels. Importing
such templates into a project will add all of its panels to the project.

Insert panel
template in
Timeline view

You can now insert a template made of one or several panels between two panels in the
Timeline view. In the past, this was only feasible in the Thumbnails view.

3D Objects
Feature

Description

Render 3D model
in 2D scene

When attempting to add a 3D model to a 2D scene, you now have the option of rendering
the 3D model into a 2D layer so it can be added to the scene without converting it to a 3D
scene.
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Feature

Description

Export to PDF
Feature

Description

A Render Scene Layout Panel option was added to the Panel tab of the PDF Profile dialog.
When enabled, each scene that has a camera movement will have special "layout"
thumbnail added before the thumbnails for its panels. The layout thumbnail contains the
camera movement for the entire scene as well as the artwork of the first panel in the scene.

Render Scene
Layout Panel

Display Camera
Mask

The Display Camera Mask option was added to the Panel tab of the PDF Profile dialog.
When enabled, a mask covers the part of the panel that is not covered by the camera frames
or the camera's trajectory. This means that only the artwork that is covered by the camera
will be visible in the thumbnails. The colour of the mask can be customized.
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Feature

Description

Frame Snapshots

A Frame Snapshot option was added to the Panel tab of the PDF Profile dialog. When
enabled, panels containing snapshots will be rendered from the point of view of the camera
at the time of the snapshot. The panel's thumbnail will only display the artwork inside the
camera frame, and the camera movements will not be rendered over the thumbnail.

Export to Bitmap
Feature

Description

When a panel has several snapshots, it is now possible to export all the snapshots for that
Export All
Snapshots

panel in different image files.
Previously, only the main snapshot of a panel was exported when exporting bitmap images,
and it was only possible to export several snapshots for a single panel when exporting to
PDF.

Export to Harmony Scenes
Feature

Description

Write node
parameters

It is now possible to configure some of the rendering parameters of the Write node when
exporting Harmony scenes, namely the location, prefix and image format of rendered
frames.
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Feature

Description

Group layers

Group layers in your project now get exported in Harmony scenes. Drawing layers are
created inside their respective group, under a peg which preserves the group
transformations and animations.

Exposure of
rendered frames

When exporting Harmony scenes as rendered images, static images are no longer rendered
over and over again at every frame. Instead, they are rendered once and exposed until the
image changes, saving on export time and disk space.
When exporting over existing Harmony scenes, you now have the option to overwrite all
Storyboard Pro scenes with conflicting names simultaneously, instead of having to specify
to overwrite each conflicting scene one at a time.

Overwrite All

Export both
Merged and
Individual Tracks

When exporting Storyboard Pro scenes, you can choose to export each scene's audio in
both separate audio tracks and one mixed down audio track. Both the individual audio
tracks and the merged audio track will co-exist in the exported scenes.

Export Audio
Feature

Description

Export both
Merged and
Individual Tracks

When exporting audio, you can choose to export the audio tracks in your project separately
and mixed down into one audio track at the same time.
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Project Management
Feature

Description

Only merge
modified panels
(Track changes)

When merging and replacing projects that were extracted from your current project, you
can now choose to only import panels that were tracked as changed in the projects being
imported.

Replace artwork
only

When merging and replacing projects that were extracted from your current project, you
can choose to ignore the changes in the timing of panels and scenes as well in the position
and animations of layers, and only import the changes done on the project's artwork.

Conformation
Feature

Description

Optional image
rendering

When exporting your project for conformation, you can elect to skip exporting the images.
This can be useful if you have already exported your project and need to export it again, but
don't want to wait for the images to be rendered again.
When importing a sequence into your Storyboard Pro project, you can elect to not import

Optional video
import

Rectify Static
Camera

the panels, and only import the audio tracks or the captions instead.
With this option available, you can export a soundtrack composed in a video editing
software into an XML or AAF sequence, then import it into your Storyboard Pro project
without affecting your storyboard panels.
The Rectify Static Camera option has been added to the Conformation Export dialog. This
option makes it so scenes in which the camera is at an angle and does not have any camera
movements are rendered as if the camera was straight.

Preferences
Feature

Description

Preserve project
length when
adding transitions

By default, when adding transitions, the length of the project shortens by the length of the
transition. This is because a transition causes the next scene to start playing before the
current scene finishes playing. With this option enabled, adding a transition between two
scenes will automatically extend the length of both scenes by half the length of the
transition, allowing the project to remain the same length.
This preference was added to the General tab of the Preferences dialog.
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Feature

Description

Ignore
Modifications to
Captions
in Auto Tracking
Mode

By default, when Auto Tracking Mode is enabled, any change made to a panel will activate
tracking for that panel. With this option enabled, making changes to a panel's captions will
not activate tracking for that panel.
This preference was added to the General tab of the Preferences dialog.

It is now possible to display time in the Timeline view, the Thumbnails view and exported

Display time in feet
and frames

PDF documents in feet and frames. In the context of an animation production, a foot
corresponds to a vertical foot of animation exposure sheet, which covers to 16 frames.
Hence, each foot corresponds to 16 frames in your project.
This preference was added to the Global UI tab of the Preferences dialog. In the Time
Display Units section, each time display setting is followed by a drop-down menu in which
you can either select Timecode, Frames or Feet + Frames.

Scripting
Feature

Current frame

Layer management

Description

The frame class, which allows you to check and change the current frame, was created. It
contains the following methods: current, setCurrent and moveFrames.
The following methods were added to the LayerManager class: isShared, isEmpty and
mergeLayers.
Additionally, the getLayerSelection method was added to the SelectionManager
class.

Timeline markers

The TimelineMarkers class was created. It contains several methods to manage timeline
markers in your project.

Tool presets

The ToolPresetManager class was created. It allows you to list and select tool presets.

Panel colour

The setPanelColor and getPanelColor methods were added to the
StoryboardManager class.

Export AAF

The exportToAAF method was added to the ExportManager class, allowing you to script
the export of your project as an AAF sequence for conformation.
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Bug Fixes
l

Fixed issue where curved lines drawn quickly with pen tablet would appear segmented and dented with
low-end video cards.

l

Fixed issue where overwriting a Storyboard Packed File (.sbpz) when splitting or extracting the current
project would delete the target project's parent directory.

l

Fixed a crash caused by an error message occurring when the computer wakes from sleep mode.

l

Fixed a randomly occurring crash when animating a layer.

l

Fixed a memory leak that occurred when deleting panels while their thumbnails were about to be
generated.

l

Fixed crash when flipping a scene if the Stage or Camera view are not in the current workspace.

l

Fixed a rare crash when dragging and dropping the last scene of a project to move it earlier in the
project.

l

Fixed a crash when opening an already open project using the command line with the argument panelid and cancelling on the dialog alerting that the project is already open.

l

Fixed issue where scale factor of 3D models would not be preserved in exported Harmony scenes.

l

Fixed issue where attempting to generate an auto-matte on a shared drawing would discard the shared
drawing.

l

Fixed issue where exporting a dynamic brush preset containing multiple drawings and importing it
under a different user account would only import the first drawing of the dynamic brush.
NOTE
Dynamic brushes have been renamed Stamps in Storyboard Pro 6.0.

l

Fixed issue where a shared drawing would be flipped all across the project when flipping a scene
containing the shared drawing. Now, a shared drawing that is in a scene that gets flipped will be
unlinked from the original drawing and linked to a flipped version of the shared drawing, which is also
shared.

l

Fixed issue where pen tablet input would be offset when working with several monitors set to different
scaling factors on Windows.

l

Fixed an issue where flipping a scene would not work if the scene contained a shared drawing and an
even number of panels.

l

Fixed issue where converting a shared drawing from one art type to the other would not update the art
type of the original shared drawing.

l

Fixed issue where exporting a Windows Media Video (.wmv) file would fail without any error message if
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attempting to overwrite a file that is opened in a movie player.
l

Fixed issue where projects split or extracted in Storyboard Packed File (.sbpz) format would have the
project title extractproject_temp.

l

Made the Split Project and Extract Project dialog create projects in the current project's format (.sboard
or .sbpz) by default.

l

Fixed issue where background layer of current panel would appear over onion skin.

l

Fixed the icon that appears over panels in the Thumbnails view when the Lock Scene and Panel Names
option is enabled.

l

Fixed issue preventing from selecting layers in very short panels when making a selection of layers from
multiple panels.

l

Fixed issue where applying a blur effect on a selection of multiple layers across multiple panels would
ignore layers in very short panels.

l

Fixed issue where panels got expanded even if the Panels > Expand Panel PDF option is disabled when
exporting a PDF with one panel per page.

l

Fixed issue where camera framing would be wrong when exporting a project in 16 field for
conformation.

l

Fixed issue where the waveform would not be immediately visible for sound clips that were added to the
project by copying and pasting them, or by importing a sequence for conformation.

l

Made the General tab the default tab in the PDF Profile dialog.

l

Fixed issue where timeline markers would appear selected when scrolling the Timeline view until the
currently selected timeline marker was out of the visible range.

l

Fixed issue where buttons in the Find Text in Captions dialog would appear too big and overlap each
other on macOS.

l

l

Fixed the size of the following user interface elements in High DPI / Retina Display mode:
l

The Zoom drop-down in the Stage, Camera, Top and Side views

l

The Browse button in the Split Storyboard dialog in High DPI / Retina Display mode.

Fixed the following localization issues:
l

Cropped text in the Japanese Welcome Screen.

l

Untranslated options in the Blur dialog.

l

Untranslated tool tips of the Play and Play Selected Panels buttons in the Pitch Mode workspace.

l

Untranslated options in the Generate Auto-Matte dialog

l

Untranslated list names in the script selection dialog.
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